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MCF5445X平台 Linux环境搭建

1.概述

MCF5445X平台下的 Linux环境搭建主要包括 LTIB的安装，tftp server的安装和配置，

NFS服务器的安装和配置，Samba的安装和配置，目标机 telnet服务器的配置，目标机 vsftpd
的配置以及 ECLIPSE的配置。LTIB的安装主要是 BSP，编译器和目标机文件系统的安装以

及 Linux 内核的编译等。tftp server 的安装和配置是指主机 tftp 服务器的安装和配置，用于

下载内核调试。NFS 服务器用于支持 NFS文件系统。Samba用于Windows和 Linux之间的

文件共享。目标机 telnet服务器用于远程登录。目标机 vsftpd 用作 ftp服务器。ECLIPSE主

要是用于编译应用程序和调试应用程序。

以上主机安装均是指在 Redhat5.5下的安装。

2. LTIB的安装

在安装以前，先将 SELinux关掉。选择菜单“System”->“Administration”->“SELinux
Management”，弹出 SELinux Administration 对话框，在对话框的右边，选择“System Default
Enforcing Mode”的下拉框为“Disabled”。

2.1.安装 BSP

在你的机器上请按如下步骤安装 LTIB：
1．以超级用户 root登录，在你的机器上挂载 ISO映象文件：

#mount –o loop MCFV4M_20090729_ltib.iso /mnt/<挂载点>
2．以非超级用户登录，安装 LTIB：
#/mnt/<挂载点>/install
在此会提示输入安装路径。注意请确保在安装路径上有正确的权限。

2.2.运行 LTIB

进入安装目录，运行./ltib。
#cd <安装目录>
#./ltib –m selectype
弹出对话框，在第二行中选择 Selection (Freescale MCF54455 Evaluation Board)，然后退

出保存。再运行./ltib。
#./ltib
第一次运行./ltib时会编译大量的主机安装包并安装，这可能花费好几分钟的时间。

一旦编译安装完成，你可以发现如下目录/映象文件：
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rootfs/ 目录，在目标机上布置的根文件系统。

Rootfs/boot/uImage u-boot启动的内核映象文件。

rootfs.jffs2 jffs2根文件系统映象文件。

/opt/freescale m68k主机工具如编译器等。

如果想重新编译所有的安装包，可按如下步骤：

1．#./ltib –m distclean
会提示你做出选择，输入 yes执行 distclean。
2．运行./ltib
#./ltib

3.配置环境变量

经过以上步骤，就已经安装完成 LTIB。为了能直接编译应用程序，还应配置环境变量。

打开 bash_profile文件：

#vim ~/.bash_profile
找到第 10行，改为：

PATH=$PATH:$HOME/bin:/opt/freescale/usr/local/gcc-4.3.43-eglibc-2.5.43/m68k-linux/bin
然后保存退出。

重启机器或者执行以下命令：

# source ~/.bash_profile
然后测试一下：

#m68k-linux-gnu-gcc –v
如果看到有信息输出，说明配置成功了。

4. tftp server的安装和配置

在安装以前，先将防火墙关掉。选择菜单“System”->“Administration”->“Security Level
and Firewall”，打开“Security Level Configuration”对话框，点击“Disabled”。然后按如下

步骤安装：

1．先找到安装包 xinetd-2.3.14-8.i386.rpm，tftp-server-0.42-3.1.i386.rpm
2．然后执行如下命令：

#rpm –ivh xinetd-2.3.14-8.i386.rpm
#rpm –ivh tftp-server-0.42-3.1.i386.rpm
请注意是否有正确的权限。安装完成后，应创建一个 tftp 目录，以便目标机能够通过 tftp
下载文件，这里假定是/tftboot。
3．修改配置文件/etc/xinetd.d/tftp，改成如下：

service tftp
{

socket_type = dgram
protocol = udp
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wait = yes
user = root
server = /usr/sbin/in.tftpd
server_args = -s /tftpboot
disable = no
per_source = 11
cps = 100 2
flags = IPv4

}
至此，tftp server安装配置完成，只需重启 tftp服务即可。

4．重启 tftp服务：

#/etc/init.d/xinetd restart

5. NFS的安装和配置

在安装以前，先将防火墙关掉。选择菜单“System”->“Administration”->“Security Level
and Firewall”，弹出“Security Level Configuration”对话框，点击“Disabled”。然后按如下

步骤安装：

1．以超级用户登录，在命令行中输入 setup命令：

#setup
在弹出的对话框中，选择“系统服务”，然后选择 nfs服务，然后确定退出。

2．修改/etc/exports，添加如下的行：

/tftpboot/ltib <目标机 IP>(rw,no_root_squash,async)
这里的目标机 IP可以是一个 IP地址，也可以是某个网段，比如：

/tftpboot/ltib 192.100.185.*(rw,no_root_squash,async)
3．重启 NFS服务：

#/sbin/service nfs restart

6. SAMBA的安装和配置

1．以超级用户登录，在命令行中输入 setup命令：

#setup
在弹出的对话框中，选择“系统服务”，然后选择 smb服务，然后确定退出。

2．选择菜单“System”->“Administration”->“Samba”，弹出“Samba 服务器配置”

对话框。选择菜单“首选项”->“服务器设置”，弹出“服务器设置”对话框。在

“基本”页的“工作组”中输入“mdserver”。在“安全性”页的“验证模式”一栏

选择“共享”，在“来宾帐号”一栏选择一个用户名。然后确定退出。

3．点击“添加共享”，弹出“创建 Samba共享”对话框。在“基本”页的“目录”一

栏，输入或选择一个目录。同时将“可擦写”和“显示”打勾。请注意确保在第 2
步选择的用户对该目录具有操作权限。在“访问”页选择“允许所有用户访问”，
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然后确定退出。

4．测试一下配置是否正确。在 windows 的开始菜单中点击“运行”，弹出“运行”对

话框，输入“\\<IP地址>”。如能打开浏览窗口，说明配置正确。

7.目标机 telnet服务器的配置

为了能远程登录目标机，需要在目标机上配置 telnet服务器。可通过以下步骤来配置：

1．在编译 BusyBox源代码时，将 Networking Utilities --->[*] telnetd和 Networking
Utilities ---> [*] inetd选上。

2．在编译Linux内核时，将Device Drivers ---> Character devices --->[*] Legacy (BSD)
PTY support选上。

3．请确保/usr/sbin/目录下存在 inetd和 telnetd。
4．在/etc目录下确保存在 fstab，service，inetd.conf，passwd文件。

5．确保 fstab文件中存在 devpts /dev/pts devpts mode=620 0 0 这一行。

6．确保 services文件中存在 telnet 23/tcp这一行。

7．确保 inetd.conf中存在 telnet stream tcp nowait root /usr/sbin/telnetd telnetd
这一行。

8．确保 passwd文件中存在 root::0:0:root:/root:/bin/sh ，表示没有密码的 root帐号

telnet服务是通过 inetd启动的。系统启动时根据配置文件运行了 inetd。

8.目标机 vsftpd服务器的配置

1．将文件 vsftpd-2.0.5.tar.gz ，vsftpd-2.0.3-sysdeputil_uc.patch，vsftpd-2.0.5-config.patch，
vsftpd-2.0.5-syscall2.patch拷贝到/opt/freescale/pkgs目录下。

2．将文件 vsftpd.spec拷贝到 <litb安装目录>/dist/lfs-5.1/vsftpd目录下。

3．在<litb安装目录>下输入如下命令：

#./ltib –m prep –p vsftpd
#./ltib –m scbuild –p vsftpd
4．编译成功后，将 vsftpd下载到目标机的/usr/sbin/目录下。请确保目标机/etc/vsftpd.conf
文件的存在。如果没有这个文件，可到 vsftpd源代码下拷贝。最后还要确保目标机/var/ftp
目录的存在。ftp服务也是通过 inetd启动的。在这种情况下启动的 vsftpd.，请确保目标

机/etc/inetd.conf文件中有这一行：

ftp stream tcp nowait root /usr/sbin/vsftpd vsftpd
当用匿名登录时，默认是访问/var/ftp 这个目录的。如果用其它用户名登录时，则访问

的是/home目录下的相应的用户名目录。如果要添加一个用户名，可以用 adduser命令，

比如：

#adduser –h /home/ut –S ut123
此时会要求输入密码，输入密码。

这样就可以用 ut123这个用户名登录了。
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9. ECLIPSE的配置

ECLIPSE主要是为编译和调试应用程序提供可视化环境。其配置主要包括 GCC编译器

的配置，GCC链接器的配置，GCC汇编器的配置，GDB的配置等。下面就以一个例子

来说明如何进行这些配置。

9.1.运行 Elipse

选择菜单“应用程序”->“编程”->“Eclipse”，打开 Eclipse。

9.2.创建一个工作空间 testtest
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9.3.创建一个工程
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9.4.添加一个 C文件
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9.5.指定 GCC编译器为m68k-linux-gnu-gcc
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9.6.指定 GCC链接器为m68k-linux-gnu-gcc
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9.7.指定 GCC汇编器为m68k-linux-gnu-as
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9.8.编译程序
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9.9.配置 GDB为m68k-linux-gnu-gdb



深圳市深智电力科技有限公司

深圳市深智电力科技有限公司 22 / 76



深圳市深智电力科技有限公司

深圳市深智电力科技有限公司 23 / 76



深圳市深智电力科技有限公司

深圳市深智电力科技有限公司 24 / 76

9.10. 在目标机启动 gdbserver

将编译的程序 abc下载到目标机，并启动 gdbserver。
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9.11. 设置断点，开始调试程序
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9.12. 中文显示

为了支持中文显示，还应设置 Eclipse编码。选择菜单“Window”->“Preferences”。点

击“Workspace”。在右边的“Text file encoding”由 Default改为 Other。在 other中选中

GBK。如选项中没有，则输入“GBK”三个字符。
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10. Linux虚拟机和Windows文件共享的配

置

Linux虚拟机和Windows之间的文件共享可通过共享文件夹来达到共享的目的。为此需

要安装 VMware Tools。具体步骤如下：

1．选择菜单“VM”->“Install VMware Tools”。
2．打开终端，以超级用户登录。

3．输入命令：

#mount /dev/cdrom /mnt/cdrom
4．进入安装目录，进行安装：

#cd /mnt/cdrom
#rpm –Uhv VMwareTools-7.8.4-126130.i386.rpm

5．配置 VMware Tools，在命令行输入：

# vmware-config-tools.pl
此时会有一些提示输入 yes或者 no进行配置，一般按默认的配置即可。
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安装完成 VMware Tools之后就可以实现虚拟机和Windows之间的文件共享了，选择菜

单“VM”->”Setting”，弹出对话框。选择”Options”->“Shared Folders”，点击“Add”，
弹出对话框。点击“Next>”，选择一个要共享的目录，并输入一个共享名字（随便输）。

点击“Next>”，然后点击“Finish”，到此就完成配置了。然后进入目录/mnt/hgfs/就可

看到共享的文件了。

11. SFU的安装和配置

SFU是Windows下的 NFS 服务器。这个主要是为了方便虚拟机和目标机可以同时

Windows下的文件。其安装和配置如下：

11.1. 安装 SFU

1、下载软件 SFU
http://download.microsoft.com/download/a/1/c/a1ca7af1-a6e3-46e7-874a-4c5d8c0fb3b7

/SFU35SEL_EN.exe
2、编辑用户组 group文件 和密码 passwd文件，并复制到 C:\

例如：

passwd内容

root:x:0:0:root:/root:/bin/sh
group内容

root:x:0:
3、运行 SFU35BETA_EN.exe，这是一个自解压文件，指定一个目录，释放压缩的文件。

4、在释放目录中，运行 SfuSetup.msi，出现 Micorsoft Windows Services for UNIX Setup
wizard窗口。

5、点击 Next，出现 Customer Information窗口。

6、点击 Next，出现 License and Support Information窗口，选中“I accept the agreement”。
7、点击 Next，出现 Installation Options窗口。

8、选择 Custom Installation，点击 Next，出现 Selecting Components窗口。

9、点击 Utilities目录项，选择 Entire feature will not be available，该项的图标变为一个

棕色的叉号。

10、对“Interix GNU components”“Remote Connectivity”使用相同的选择。

11、点击 NFS目录项，选择 Entire Feature (including all subfeature if any) will be installed
on local hard drive，该项的图标变为一个白色背景的驱动器。

12、对“Authentication tools for NFS”使用相同的选择, 选择 Entire Feature (including all
subfeature if any) will be installed on local hard drive。
13、最终只有“Authentication tools for NFS”和“NFS”两项是完全安装，其他各项都不安

装。

14、点击 Next，出现 User Name Mapping窗口，选中 Password and group files。
15、点击 Next，在 Password file path and name下的空白栏中输入 C:\passwd，在 Group file
path and name 下的空白栏中输入 C:\group。
16、点击 Next，出现 Installationg Location窗口，选择安装位置。 这里的安装位置的盘

http://download.microsoft.com/download/a/1/c/a1ca7af1-a6e3-46e7-874a-4c5d8c0fb3b7/SFU35SEL_EN.exe
http://download.microsoft.com/download/a/1/c/a1ca7af1-a6e3-46e7-874a-4c5d8c0fb3b7/SFU35SEL_EN.exe
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必须是 NTFS 格式

17、点击 Next，开始安装（约 21MB）。最后选择 Finish，结束安装。如提示重启，则

重启。 （以上安装过程比较简单，引用网络上文章。）

11.2. 共享Windows主机目录

1、对要共享的目录，右键点击出现下拉菜单，选择“属性”，出现目录属性窗口。

2、选择“NFS Sharing”选项卡，选中 share this folder；指定共享名（Share name，一

个简单的名字，大小写无关，如 dir）；字符编码（Encoding）选择 GB2312-80；选中

Allow anonymous access；点击 Permissions，出现 NFS Share Permissions窗口，设置共

享文件夹读写属性。
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3．在 Type of access下拉菜单中选择 Read-Write（可读可写）；要使目标板对本机文件

有 root权限，选中 Allow root access。
4．设置完，点击 OK按钮，回到目录属性窗口。

5．点击“安全”选项卡，添加 everyone,使之允许读取，控制，或者完全控制。
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11.3. 配置 Services for UNIX Administration

1、选择开始 ->程序 ->Windows Services for Unix->Services for Unix Administration 启动

Services for UNIX Administration，
2、出现设置窗口后，点击 左边子窗口 User Name Mapping，再点击标签栏“Map”，然后点

击 show User Maps，出现如下画面：

点击 service for NFS，如下设置：
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点击 locking,如下设置：

点击 Client Group,如下设置：
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点击 Server Settings,如下设置：

点击 User Name Mapping,，如下设置：
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点击Maps，出现如下画面：

点击 Show User Maps, 如下设置，然后返回：
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点击工具——>文件夹选项——>查看，去掉“使用简单的文件共享前”的勾，然后确

定，如下：
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至此设置完毕。

11.4. 启动目标板，并在目标板上挂载 windows目录

接好网线，启动目标板。运行 mount命令来挂载 NFS目录：

#mount –t nfs –o nolock 192.100.1.92:hyca /mnt/nfs
hyca为共享的目录名。显示一下目录内容，应为Windows机器上的共享 NFS目录内容。
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11.5. 虚拟机下的 Linux安装

要在虚拟机下安装 Linux，必须要有虚拟机和 Linux安装光盘。虚拟机的安装不在此描述。

此处是假设虚拟机已经安装好了的情况。我们这里所说的虚拟机是指 VMWare 6.5，Linux
是指 Fedora 8。 我们这里主要描述 Linux的安装。

11.6. 新建一个虚拟机

启动 VMWare，点击菜单“File”->“New”->“Virtual Machine”，出现如下对话框：
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点击 Finish，开始进行虚拟机配置。
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点击 OK，配置完成虚拟机，然后点击“Power on this virtual machine”按钮，启动虚拟

机。

11.7. 安装 Linux
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点击回车
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点击 OK

点击 Test
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点击 OK

点击 Continue
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此时点击右下角的光盘图标，点击 Connec，再点击上图的 OK
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点击 Next

选择 English（English），点击 Next
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选择 U.S.English，点击 Next

输入 Installation Number：2515dd4e215225dd，点击 Next
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选择“Remove linux partitions on selected drivers and create default layout”，点击 Next

选择 Yes
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选择 Next

选择时区 Asia/Shanghai，点击 Next
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输入根用户口令（六位），单击 Next

选择 Software Development，Virtualization，Web Server。选择 Customize now，单击 Next
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在“桌面环境”中，选择“GNOME 桌面环境”。
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在“应用程序”中，选择，“图形”，“图形化互联网”，“基于文本的互联网”，“编辑器”。

如果需要，也可以选择其它程序。

在“开发”中，选择 “GNOME 软件开发”，“X 软件开发”，“开发工具”，“开发库”。



深圳市深智电力科技有限公司

深圳市深智电力科技有限公司 67 / 76

在“服务器”中，选择“DNS名称服务器”，“FTP服务器”，“Windows 文件服务器”，

“万维网服务器”，“打印支持”，“服务器配置工具”，“网络服务器”。

在“基本系统”中，全选。
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在“虚拟化”中，选择“Xen”。

在“语言支持”中，选择“中文支持”。然后点击“Next”。
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点击“Next”，开始安装。

点击“Reboot”，重启之后会出现如下画面：

点击“Forward”,前进。
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选择“Yes，I agree to the LICENSE Agreement”，点击“Forward”。

禁用防火墙，点击“Forward”。
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选择“Yes”.

SELinux设置选择“Disabled”，点击“Forward”。
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点击“Yes”。

不选择“Enable kdump”，点击“Forward”。
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设置时间，点击“Forward”。

选择“No,I prefer to register at a later time.”，点击“Forward”。
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点击“No thanks, I’ll connect later.”
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点击“Forward”。

创建用户名，密码，密码不能少于六位，点击“Forward”。

点击“Forward”。
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点击“Forward”。

点击“OK”，点击“Finish”。
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